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Foreword

Ever since RapidWeaver 4 was announced, there has been far more than just a software upgrade in the pipeline: an 

entirely-new website and add-ons area; and this - a freshly updated manual. Almost one hundred pages of reference and 

tutorials to show you how RapidWeaver 4 works, and to help you easily create beautiful web-standards-based sites.

Throughout the course of this user manual, we’ll be building a site using all the tools within RapidWeaver. You can visit 

the live demonstration site at http://www.california-roadtrip.com

Thanks for choosing RapidWeaver as your Website creation tool of choice, and happy weaving! 

Andre, Aron, Ben, Dan, Danny, Josh, Kevin and Nik

Brighton, England

May 2008
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Welcome

Welcome to the RapidWeaver Manual. The first part of the manual is dedicated to helping you quickly start using 

RapidWeaver and create your website, whilst later in the manual you can find a feature-by-feature run down of 

RapidWeaver’s options.

Conventions Used

RapidWeaver Menus

These are a series of Menu options to follow in RapidWeaver’s menubar menu system. The example 

below takes you to the File menu, and to suboption ‘Re-Publish All Files’.

File > Re-Publish All Files

Keyboard Shortcuts

RapidWeaver has a significant number of Keyboard Shortcuts. The examples below show the shortcut 

to italicise text using the Command (Cmd or  key) and the letter i, and to publish your site using the 

Command (Cmd or  key), Shift and the letter k.

Cmd + i (Italicise Text)

Cmd + shift + k (Publish Site) 

Getting Started with RapidWeaver
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Installing RapidWeaver

Installing RapidWeaver is quick and easy. All you need is the rapidweaver4.dmg file from either the Realmac 

Software website or your retail DVD.

Drag the RapidWeaver icon (on the left) onto the Applications folder alias in the disk image (which is provided to 

make installation as quick and as easy as possible). Then all you need to do is eject the disk image and delete 

the original download .dmg file from your Downloads folder. Now that you have installed RapidWeaver, it’s time 

to find it in your Applications folder and launch it.
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Registering RapidWeaver

Whilst we would love you to register RapidWeaver with a shiny new serial number and unlock the demo version 

you have downloaded, you can run it in demo mode for as long as you like. The demo limits your project to three 

pages.

When RapidWeaver launches for the first time, you will be prompted to do one of three things:

Purchase RapidWeaver (Either a full licence, or an upgrade from version 3.5)• 

Enter a valid serial number• 

Run RapidWeaver in Demo mode• 

After you’ve made your choice, go ahead and create a new project by using the ‘New Project’ button, or the File 

> New Project menu option. A window such as the one shown in Figure 1 will appear.

 RapidWeaver’s Main WindowFigure 1:
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The Basics of RapidWeaver

You will need to add a page to your project to get started. This is done via the [+] button in the bottom left of the 

Application’s main screen. A list of the installed Page Types will appear. In this Getting Started guide, we’re going 

to add a Styled Text page to get our website up and running.

The large white text area is the Styled Text area, allowing you to enter text, format it and drag and drop in photos 

and movies.

If you want to bold, underline or italicise text, then all the usual keyboard commands work just like in other Mac 

applications (e.g. Cmd + B for Bold, Cmd + i for Italic, Cmd + U for underline).

Tip: To place a photo into any styled text area (such as a Styled Text page, Blog 

Entry or the Sidebar), simply drag and drop it in. If you want to access your 

iPhoto or Aperture library, use the shortcut Cmd + 4 or go to the View > Show 

iMedia Browser menu option to access the built-in iMedia Browser.

 The iMedia BrowserFigure 2:

 RapidWeaver’s Main InterfaceFigure 3:
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Choosing a Theme

RapidWeaver’s theme-based workflow allows you to focus on the content in Edit mode. But to bring together a 

site, you will need to choose a theme it. In the main menu bar the ‘Themes’ button shows and hides the Theme 

Browser. From the there you can choose a theme for your site by simply clicking on the theme’s image. You can 

customise the theme further via the ‘Theme Variations’ area of the Page Inspector.

Adding a link to another page

Of course, you will want to create links to other pages, either within your site or to an external page on another 

website. With RapidWeaver you don’t need to write any code to do this. Highlight the text you want to link, and 

then at the bottom of the window click the ‘Add Link’ button. You can either enter a URL, or choose a page 

inside the RapidWeaver project from the drop-down menu titled ‘Page’. If you link to a page in your project, 

RapidWeaver will always ensure that the tracks the link to ensure it is always correct.

Editing the Site Title and Slogan

Within the site, you will notice thepage has a title of ‘My Site’, and slogan of ‘Changing the world, one website 

at a time’. To change them, open up the Site Setup sheet by clicking the ‘Setup’ button on the RapidWeaver 

toolbar, or use the keyboard shortcut Cmd + 1. The settings for the Site Title and Slogan are found under the 

‘General’ tab.

 Theme BrowserFigure 4:

 Add Link SheetFigure 5:

 Site Setup SheetFigure 6:
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Arranging the navigation menu

RapidWeaver generates the navigation menu of the site automatically based on the arrangement of pages in the 

left-hand Page List. To create a sub-page in the navigation structure (irrespective of the page’s folder) simply 

drag the soon-to-be sub-page onto the page that will be above it in the menu as shown to the left. A disclosure 

triangle will appear to show that there are sub-pages and allow you condense the sub-menu in the Page List to 

take up less screen space).

Creating a Photo Album

RapidWeaver has a built-in Photo Album page type, allowing you to create a CSS-based gallery, or a Flash 

slideshow. Tou can also choose whether to use iPhoto integration to build your page, or simply drag and drop 

images in from the Finder.

Integrating with your iPhoto Albums

If you manage your photos in iPhoto, you don’t need to export them from iPhoto before you start: RapidWeaver 

will read your iPhoto library and you can simply select an existing album from within RapidWeaver. After adding 

a Photo Album you will be presented with a screen similar to that shown in Figure 8.

 Creating Sub-pagesFigure 7:

 iPhoto IntegrationFigure 8:
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On the left-hand side is a list of all your iPhoto albums. Clicking on an album will select those photos for the 

slideshow, and they will then appear in the right-hand column.

RapidWeaver also reads the data from your iPhoto library to keep the information like a photo’s title intact. You 

can also apply the image’s name in iPhoto as a caption in the gallery - we will show you how to do this later 

on).

To remove an image from a gallery, simply uncheck the box on the left of the image, and RapidWeaver will then 

ignore that photo.

Creating a Drag and Drop Gallery

If you don’t use iPhoto, or simply have the pictures you want to add in a folder elsewhere on your Mac, you can 

also create photo albums using Drag and drop. To begin with, you will need to ensure that you have selected 

‘Your Album (Click to change)’ option, instead of an iPhoto album, at the top of the left column. If you want the 

album to have a different name when displayed, simply double click the text, and edit it.

As well as being able to drag and drop images from the OS X Finder, you can use the iMedia Browser (found un-

der the View > Show iMedia Browser menu option or keyboard shortcut Cmd + 4) to drag in files from Aperture, 

iPhoto, or your User Account’s ‘Pictures’ folder to add them to the Photo Album.

Note:
RapidWeaver only ‘ignores ‘photos 

(and stores that information inside 

your save file). It does not affect 

your iPhoto library in any way.

 Drag and Drop Gallery CreationFigure 9:
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With the photos now added to your page, it’s time to customise the appearance of the finished album. To do 

this, click the ‘wrench’ button below the Page List. The ‘Page Inspector’ opens to show the plugin settings tab 

as shown in Figure 10.

The ‘General’ sub-tab contains most of the settings should you wish to use a CSS-based gallery. The descrip-

tion area is shown directly above all the thumbnails. Simply enter your description in the text box, and you’re 

all set.

To get a Flash slideshow running, you will first need to check the ‘Use Flash Slideshow’ box in the ‘General’ sub-

tab (shown in Figure 10) and then configure the settings though the ‘Flash Slideshow’ sub-tab.

Click Preview to view your Photo Album (shown in Figure 11).

 Photo Album SettingsFigure 10:

 The finished Photo AlbumFigure 11:
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Setting Up a Contact Form

Once you have got your site ready to publish, you might want to add a Contact form that allows you to receive 

emails from website visitors. A contact form plugin ships with RapidWeaver, and can be added like any other 

page.

Unless you want to customise the fields in the form RapidWeaver has added all the fields needed for a basic 

contact form as shown above. You will want to click the ‘wrench’ icon below the Page List to customise the mes-

sages shown on the form, and to which email address you want to send the completed form to (see Figure 13).

Note:
The Contact Form page type 

requires a host that supports PHP. 

Due to .Mac not supporting PHP, 

the Contact Form will not work 

when published to .Mac webspace.

 A Basic Contact FormFigure 12:

 Contact Form OptionsFigure 13:
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Starting a Blog

RapidWeaver comes with a fully-featured blog page-type, featuring auto-archiving, permalinks and RSS genera-

tion. To get started, simply select ‘Blog’ from the Add Page sheet. and then add an entry by choosing the [+] 

button in the middle-left of the Edit view.

In the list above, an entry will appear with the date and time already filled in. A post details area will slide out 

from the right where you can enter the title of the post and more. In this case, enter a title for your blog post, a 

Category or two, and perhaps some tags that you wish to associate with the entry.

Tip: Categories and Tags, whilst similar, serve different purposes. Categories 

are typically more sweeping areas, so a blog post with a photo in could be 

categorised as “Photography”, whilst the tags would define the content a little 

more: in this case the subject of the photo (e.g. California, Beach, Sunshine 

could all be considered tags).

In the ‘Body’ enter the content you wish to use as a blog entry: as it’s a styled text area, you can enter anything 

from a movie, picture or even HTML code, and use the Rich Text formatting tools. That is not everything Rapid- That is not everything Rapid-

Weaver has to offer in the blog plugin: you can generate RSS feeds, allowing people to subscribe to your blog in 

a newsreader such as NetNewsWire, NewsFire or Google Reader.

 The Site Setup sheetFigure 14:

 The Blog PageFigure 15:
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Setting Up an RSS feed

Before setting up an RSS feed, you will need to tell RapidWeaver the address your site will be published to. To 

set that up we will need to open up the ‘Site Setup’ sheet (found either under the Site menu, or via the shortcut 

Cmd + 1). In the General tab, and enter the full URL of your website into the ‘Web Address’ box: Be sure to 

include the http:// that precedes any URL.

Now that the Site URL is set up, you can close the ‘Site Setup’ window and return to the main window. Below 

the Page List, select the ‘wrench’ icon and the blog settings pane will appear. On the sub-tabs choose ‘RSS’ and 

then simply check the ‘Enable RSS’ button. You can customise the feed’s properties in the boxes below: note, 

the ‘Author’ box must be an email address.

Now that the RSS options are setup, RapidWeaver will generate an RSS feed for blog entries. If you want the 

RSS feed to be restricted to merely the ‘front page’ entries (i.e. only those shown on the main blog page) you 

can do that via the RSS sub-tab.

Renaming Pages

Once you have added a few pages and some content to your site, it’s time to think about other details such as 

filenames for pages. You edit the details of each page within the Page Inspector (View > Show Page Inspector 

option, or keyboard shortcut Cmd + Shift + i). Under the General Settings tab, you will find all the settings for 

the page.

To change the name of the page shown in the navigation menu, change the Page Title to something other than 

‘Untitled Page 1’ by double-clicking in the page in the left-hand list. You should also consider changing the 

Browser Title of the page that appears in a web-browsers Window title. This is a good first step in Search Engine 

Optimisation.

To change the folder and filename for each page. If you want a page to appear at the root of the site (so at http://

www.domain.com/page.html) you simply enter a forward slash ( / ) in the Folder box. You can also type a folder 

name into the box, such as ‘apple’ (without quotation marks) and RapidWeaver will create a subfolder at the level 

the page is in the navigation bar and place the page inside that folder when exporting the site.

Whilst spaces in filenames are common-place on the desktop, you should avoid spaces in filenames on the web.   

Any webpage, image or other file you place on your website must always have an extension.

 General Page SettingsFigure 16:
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Publishing Your RapidWeaver Site

Once your site has been created, publishing your site can all be handled from within RapidWeaver via .Mac, FTP 

and SFTP.

Simply click the Publish button on the main toolbar to get started. In the sheet that pops up, you simply choose 

how you wish to upload from the drop-down menu, enter the necessary server settings, and click Publish. If 

you’re uncertain on the settings you should use to publish your site, check the Realmac Software Publishing 

Settings page, or contact your hosting provider.

On the first publish, RapidWeaver will upload every file required for your site. But after this, it uses Smart Publish-

ing to update only the files that have changed.

 RapidWeaver’s Publishing sheetFigure 17:

Note:
Web hosting is not included with 

RapidWeaver.



22

Getting Started With RapidWeaver

Main Window

RapidWeaver 4 has an all-new interface designed to fit in with the look and feel of Mac OS X Leopard (10.5). 

The main window used to build your website consists of a Web Pages List on the left and a Content pane on 

the right of the window.

You manage the pages of your website by using the ‘add’ [+] and ‘delete’ [-] buttons, located at the bottom of 

the Page List. The ‘add’ [+] button opens the Page Type Selection sheet. Simply double-click the page type you 

want to add and it will appear in the Web Pages List below the currently-selected page.

You can also add multiple page types at once by selecting any number of different page types in the Page Se-

lection sheet.

Once the new page has been added, you can drag it to another position in the list as described earlier in this 

section. You can also delete a page that is no longer needed by selecting the intended page in the list and click-

ing the ‘delete’ [-] button at the bottom of the list.

Edit and Preview

RapidWeaver uses two ‘modes’ to create your site: Edit and Preview. To edit and preview a page, first click on 

the desired page in the Page List to the left of the window to select it. Once a page is selected you can edit and 

preview its content by switching between Edit and Preview modes by clicking the ‘Edit’ or ‘Preview’ located on 

the main toolbar. You can also use keyboard shortcut Command-R to toggle between Edit and Preview modes.

View Source

Whilst a knowledge of HTML is not necessary to use RapidWeaver, you can view the HTML code view the code 

that RapidWeaver will output. To enter Code view mode, use keyboard shortcut Command-Option-U or choose 

View -> View Source. The upper portion of the view shows the HTML code as rendered by RapidWeaver. Any 

errors and warnings are displayed in the lower portion of the screen for your inspection and review. If you want 

to tidy your code when viewing the source, click the ‘Tidy Source’ button at the bottom of the code window.

Note: 
The code view is not editable.

Tip: 
You can quickly add another page 

to your site by Ctrl-Clicking (Right-

Clicking) the [+] Add Page button 

to show a list of available page 

types and add a page with a single 

click.

 The Quick-Add MenuFigure 18:
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Contextual / Action Menu

RapidWeaver provides a number of options for pages via a contextual menu for quick and easy access. Right-

clicking, or Ctrl-clicking, a page in the Page List brings up the menu and allows you to:

open the Page Inspector,• 

Duplicate, Replace or Delete the page, • 

Make the page the site Home Page, • 

Mark the page Changed or Unchanged for RapidWeaver’s smart publishing,• 

Export and Preview the page locally in a web browser,• 

Publish the individual page to your webserver,• 

Re-publish the entire site (and all its supporting files).• 

Working with Themes

Themes are website page templates that include the basic layout and architecture of each page into which you 

insert your content within RapidWeaver. In most cases, you will select just one theme and implement it through-

out your website. However, RapidWeaver also allows you to apply themes on a page-by-page basis using the 

Page Inspector.

Selecting which theme you want to use is simple. Click the Themes button on the main toolbar, or use keyboard 

shortcut Cmd + Option + T to show and hide the Theme Browser. Scroll through the theme thumbnails and click 

on the one you want to use. The selected theme will be applied to all the pages in your site.

 The Theme BrowserFigure 19:
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Themes typically have several variations that can be applied in order to easily change a particular aspect of the 

site’s layout or design. Variations such as sidebar placement, page styles, text colour, font face, page width, 

page header images, and background colour are all potential options. Variations are accessible via the Theme 

Styles tab of the Page Inspector, selectable from the Window menu or by typing keyboard shortcut Cmd + Shift 

+ i.

Right-clicking/Ctrl-clicking on a theme in the Themes Browser shows a contextual  menu allowing you 

to duplicate a theme (for subsequent customization), show the theme’s contents (for in-place editing), or to show 

the Theme Styles tab of the Page Inspector. If the theme is one you have duplicated or downloaded from a third 

party, there is also an option to Delete the theme.

Page Inspector

When it comes to customising the structure of your site, changing page titles and almost all other page-related 

settings, you’re going to be working with the Page Inspector. To access the Page Inspector select ‘Show Page 

Inspector’ from the View menu, or use keyboard shortcut Cmd + Shift + i.

The Page Inspector is organized into five sections:

General Settings:•  Edit the page’s title, file and folder names, display options, image format and page 

output.

Page Sidebar:•  Edit sidebar title (if used), and add content to the page’s sidebar.

Page Header:•  Allows you to add page assets and Meta tags, or apply the current page’s properties to other 

pages. You are also able to add custom Javascript or CSS to the selected page, or insert code above the 

<!DOCTYPE> tag.

Theme Styles:•  Customise the design of the page.

Plugin Settings:•  Any plugin options are shown in this tab - for example, the Blog setup, Contact Form, and 

Photo Album setup are all controlled from within this tab.

These options will be applied to the page you have selected in the Pages List. To apply these options to other 

pages in your project, use the ‘Apply Properties to All Pages’ option found on the Advanced tab (see below.) You 

may also pre-set many of these options in the Site Setup for pages you subsequently add to your project.

 Page Inspector TabsFigure 20:
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General Settings

When you first open the Page Inspector, you are brought to the ‘General’ tab view. Within this tab, you can edit 

the selected page’s file and folder names, display options (including whether or not to show the page in the navi-

gation menu), image format and page output, and title, slogan and copyright information. You may also specify 

encoding and set output options.

Enabled (Checked by default): 

This options dictates whether the page will be published or exported as part of your website. Unchecking this 

box will tell RapidWeaver to treat the page as a draft, and prevent the page from being published or exported.

Show in menu (Checked by default): 

This option sets whether the page appears in the site navigation menu or not. To hide the page from the navi-

gation menu, simply uncheck the box.

Open in new Window (Unchecked by default):

 If you want this page to open in a new browser window when clicked on in the navigation menu tick this op-

tion. N.B. It is generally recommended that you do not use this option on pages in your own site.

Page Title (Automatically filled from Page List): 

This title is used for the navigation menu in the site. This is also editable by double-clicking the page in the 

Page List.

Browser Title (Blank by default): 

RapidWeaver will use whatever name the page has in the navigation bar as the browser window title. If you 

want to customise this (e.g. you want the browser to display ‘Realmac Software - Blog’ instead of simply 

‘Blog’) simply enter the full title you want to appear in this area.

Folder: 

Not every page needs to be at the same structural level in your site, so you will want to place different pages in 

relevant folders.

If you want your page to be in the root directory of your site (e.g. http://www.realmacsoftware.com/my_page.

 Page Inspector         Figure 21:
General Settings tab
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php), set the page to simply / (a forward slash). Otherwise set the folder name as desired - and remember that 

you can place more than one page in a folder.

Filename: 

Sets the file name and extension for the selected page, such as ‘photos.html’ or ‘downloads.php’. The site 

home page should always be ‘index.html’ (or a variant such as ‘index.php’).

Image Format: 

When you add images to your site, RapidWeaver will convert them into the format specified here: Original, 

JPEG or PNG. Specifying ‘Original’ will leave the images in their original format, untouched and unchanged. 

If you wish to use transparent images anywhere on your site, you should leave this option set to ‘Original’ as 

images will otherwise lose their transparency on conversion.

Encoding: 

Choose how you want the browser to interpret your code. Choose between Western (ISO Latin 1), Unicode 

(UTF-8) and Japanese (Shift-JS). RapidWeaver defaults to ‘Unicode (UTF-8)’

Output:

Depending on your needs, RapidWeaver can ‘tidy’ the code it produces (to make it more readable) and also 

apply a different document type to pages. RapidWeaver exports XHTML Strict code by default, and this option 

allows you to set it to ‘XHTML Transitional’ or ‘Optimised XHTML’ (White-space removed).

Title (Unchecked by default): 

By default, the page will use the site title chosen in Site Setup. By checking this box and typing a different title, 

the default site title of this page will be replaced with the one you provide here.

Slogan (Unchecked by default): 

By default, the page will use the site slogan set in Site Setup. By checking this box and typing a different slo-

gan, the default site slogan of this page will be replaced with the one you provide here.

Copyright (Unchecked by default): 

By default, the page will use the page will use the site copyright set in Site Setup. By checking this box and 

typing a different copyright footer, the default site copyright will be replaced on this page.
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Apply to All Pages: 

This option allows you to apply any of the current settings in the Page Inspector from the active page to all 

other pages in the site file.

Page Sidebar

All RapidWeaver themes contain a ‘sidebar’ area (shown in Figure 22). You may want to add web badges, include 

a search tool for your website, or indicate your chat status in this sidebar, and you can place virtually anything 

in the sidebar to enhance a page. The sidebar has both rich-text editing and pure HTML view options available 

when editing it in the Page Inspector.

The Sidebar pane of the Page Inspector consists of two areas, the Sidebar Title field and the Sidebar Content 

box. To add an optional title to your website’s sidebar, type the title into the Sidebar Title field (you can use HTML 

code too for images). You can select the type of sidebar through the menu in the bottom right of the Page Inspec-

tor (shown in Figure 22) and Add and Remove Links via the buttons in the bottom left of the window.

 Page Inspector         Figure 22:
Sidebar Settings tab
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Page Header

The Page Header tab of the Page Inspector (shown in Figure 23) is where you will find the more advanced op-

tions for configuring your page for Search Engine Optimisation, Code Customisation and more.

Meta Tags Explained

You will probably want to ensure that your site is fully optimised for Search Engine Indexing and RapidWeaver 

allows you to Search Engine Optimise your site with meta-tags.

To add a Meta tag to a page, click the [+] button below the meta-tags table. On the selected line, double-click 

the area immediately below the ‘Name’ heading. In the selected text area, type one of Meta tag names listed 

above (without quotes). Once you have entered the Meta tag name, press the tab key or double-click the area 

to the right of the Meta tag name you created and type the Meta tag content, (again without quotes). Keywords 

should be separated by commas.

To add a Meta tag to a page, click the [+] button. On the selected line, double-click the area immediately below 

the ‘Name’ heading. In the selected text area, type one of Meta tag names listed above (without quotes). Once 

you have entered the Meta tag name, press the tab key or double-click the area to the right of the Meta tag 

name you created and type the Meta tag content, (again without quotes). Keywords should be separated by 

commas.

Expires In: 

To specify an expiry date (so if the page is time-sensitive and should be removed from a search-engines 

database after a period of time), click ‘Expires in’ checkbox and select the timeframe (minutes, hours, days, 

weeks, or months) using the popup timeframe menu. Lastly, type a value in the number field.  Search Indexing 

Robots may delete expired documents from a search engine, or schedule a revisit. If the ‘Expires in’ box is left 

unchecked, your page will not include an expiry date.

Credit RapidWeaver:

To identify your website as one that was created by RapidWeaver, select the ‘Credit RapidWeaver’ checkbox. 

If this option is selected, RapidWeaver will add the ‘Generator’ Meta tag to the head section of your site. It lets 

browsers and visitors know that your site was made with RapidWeaver. 

The ‘Credit RapidWeaver’ option does not add a visible credit or RapidWeaver badge to the site. It 

Example Meta Tags:

Name Value

description Nik’s Road Trip

keywords california, trip

 Page Inspector         Figure 23:
Header Settings tab
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merely adds tag, that are only visible in the source code, to your pages identifying the site as being 

made with RapidWeaver.

Custom CSS: 

RapidWeaver uses CSS to style all its pages, and if you’re confident enough to add styles without editing the 

theme’s stylesheets then you might want to use the Custom CSS box. By adding CSS styles to the Custom 

CSS box, you can over-ride the look and feel of a page, or add additional styles and customise how your 

page looks. Simply add the CSS exactly as you would in any other CSS editor, then link to those styles with 

standard HTML. For those who might be interested, the Custom CSS is entered into the page as inline styles 

between style tags:

Code:

<style type=”text/css” media=”all”> // Your Styles Here</style>

Custom Javascript: 

Just like the Custom CSS area, this allows you to add your own Javascript and RapidWeaver will place it inside 

the relevant script tags.

Code:

<script type=”text/javascript”> // Your Code Here </script>

Prefix: 

Any custom code entered into the ‘Page Prefix’ box will be placed before the <!DOCTYPE> tag of the page 

when rendered. For example, you may need to initiate a PHP session so that certain variables (such as names, 

passwords, email addresses, etc.) will be passed between pages. Because a PHP session has to be started 

before any other document information is loaded, you should place the PHP code in this box.
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Theme Variations

This tab (Figure 24) is used to set theme styles such as site width, font, colour schemes and sidebar alignment. 

Variations are built into a theme by the theme’s designer, so some themes may have more variations while others 

may have fewer or, perhaps, none at all. The list of available variations depends on the theme you select, and 

each group is preceded by a black triangle. Clicking the triangle will expand the variation group, and allow you 

to choose a variation for that particular option.

For example, clicking the triangle preceding ‘Sidebar Location’ presents the options of ‘Right’, ‘Left’ or ‘Hide’. 

By clicking the appropriate radio button, RapidWeaver will position (or remove) the sidebar as you require.

Page Settings

This pane displays settings for the plugin used in the active page, and will vary depending on the plugin cho-

sen.

In RapidWeaver 4, you can quickly open the Page Settings tab by using the keyboard shortcut Cmd + Option 

+ i or by clicking the wrench icon beneath the Page List in RapidWeaver’s main window.

 Page Inspector         Figure 24:
Styles Tab
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Site Setup

The Site Setup sheet allows you to configure certain site-wide options.

General Settings

Title: 

This is the site-wide title you wish to apply to your pages. By default, this is set to ‘My Website’.

Slogan: 

Just as you can add a site-wide Title, you can also define a site-wide Slogan (or Sub-Title). By default this is 

set to ‘Changing the world, one site at a time...’

Footer: 

If you want to place a copyright notice at the bottom of the page, or some links to other pages, simply enter 

them here.

 Site Setup - General Settings tabFigure 25:
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Email: Address

A link that people can click to send you an email, this is inserted into the Footer area of the page. By default, 

the option of protecting you email address from ‘Spam-bots’ is enabled to ensure your address is hidden from 

them. If you wish to turn it off, please be aware that your email address may be at risk from Spamming. You 

can turn off Email Protection from the Advanced tab.

Web Address:

This is where you should enter the full website address of your site. It’s required to set up RSS feeds and other 

settings. Be sure to start it with http:// - it should be in the form http://www.mydomain.com/

Site Logo: 

Specify a site-wide logo to apply to your pages by checking the box, and then dragging in a logo to use. The 

size of the available logo area varies from theme to theme.

WebClip Icon: 

If you wish to add a custom WebClip1 icon to display when a user bookmarks your site  on an iPhone or iPod 

touch, check the box and drag in a 57 x 57 pixel PNG image to use as your WebClip icon.

Favicon: 

A ‘Favicon’ is dislayed next to your site’s URL in most modern browsers. To add a Favicon to your RapidWeav-

er site, check the Favicon box and drag a 16 x 16 pixel GIF or ICO icon file into the Site Setup sheet.

1 https://developer.apple.com/webapps/designingcontent.php

What is a Spam Bot?
Spam Bots are pieces of malicious 

software that scour the internet for 

unprotected email addresses to add 

to Spam-email lists.
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Advanced Settings

File Links Are:

Allows you to customise how RapidWeaver displays the code that links to your site resources (such as the 

theme files). It doesn’t affect the display of your site, however should you choose the ‘Relative to Website Ad-

dress’ option, be sure that a Website Address is entered in the General tab.

Display Breadcrumb Trail:

If you wish to display a breadcrumb trail to allow users to figure out where in the site structure they are, enable 

this option.

Protect Email Address:

When RapidWeaver includes a ‘Contact Me’ link in the Footer of each page, the email address is Spam-pro-

tected by default. If you wish your email address to be displayed in plain view via your website’s code, untick 

this box.

Enable Cruftless Links:

When building links to your pages, RapidWeaver uses the full URL to point to specific files. However, you can 

tidy these URLs by enabling cruftless links. When a page is in a folder and is named either index.html, index.

php or index.htm RapidWeaver will remove the filename from URLs:

http://www.california-roadtrip.com/journal/index.html is linked as http://www.california-roadtrip.com/journal/

 Site Setup - Advanced Settings tabFigure 26:
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Google Analytics:

If you wish to track website visitors using the free Google Analytics service, enter the Analytics-supplied code 

here. RapidWeaver will apply it to all pages in your site. After adding Google Analytics to your site, you will 

need to re-upload all the pages in your site in order to receive statistics for all pages: RapidWeaver will do this 

by default, as all pages are marked as changed after adding Google Analytics code.

Template Settings

The Template tab allows you to pre-configure settings for any pages you add in the future. The settings are 

exactly like those found in the Page Inspector, except for the ‘Extension’ setting which defines what file exten-

sion new pages are given.

 Site Setup - Template Settings tabFigure 27:
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Media Inspector

The Media Inspector enables you to edit and modify the dimensions and attributes of images used in Styled-

Text pages, Blog pages and third-party page types that support styled text. You can even flip tand rotate your 

images directly within RapidWeaver.

You can access the Media Inspector by double-clicking an image you have placed in your Styled Text area or 

by selecting from the View menu. The options available in the Media Inspector are summarised in the following 

table. 

Option

Filename Sets the name of the actual file (e.g., ‘myimage.

jpg’).

Alt tag Sets the alt tag of the image, which is displayed 

while the image is loading and when you hover 

your cursor over the image.

Scale Using the arrows scales the highlighted image to a 

% of the original size, whilst retaining the aspect-

ratio of the picture.

Width and Height Un-checking the ‘Scale Image’ check box allows 

you to set the ‘Width’ and ‘Height’ values inde-

pendently. N.B. Changing these values will affect 

the aspect-ratio of the image, and may distort the 

image.

Rotation Allows you to rotate the selected image.

Crop Ticking the ‘crop’ option will mean that the image 

stays within its initial dimensions.

Flip Flips the selected image horizontally and / or 

vertically.
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Option

Shadow Check the Shadow box for RapidWeaver to render 

a shadow for the image; specify the shadow’s off-

set and blurring by editing the respective values, 

and choose the shadow’s colour.

Border Check the Border box to add a border around 

your image and specify its width and colour.

Fill Colour Specify the fill colour if necessary; used when an 

image is rotated or when a drop-shadow is added.

Because image source files can be quite large (some measuring several mega), they can dramatically increase 

the size of your RapidWeaver project file. It is generally recommended that large files be down-sized to the 

approximate size to be used in your website whenever possible, and adjust the final size and orientation using 

the Media Inspector.

Snippets

Snippets are code fragments that you may use regularly or simply wish to store for future use. To open the 

snippets window go the ‘View’ menu and select ‘Show Snippets’ or use the keyboard shortcut, Cmd + 5.

View Menu > Show Snippets

To add a snippet press the plus button located at the bottom left hand corner of the Snippets Window. To use 

a snippet, drag it into any styled or html text area in your website. Snippets can also be shared with others, via 

email, the web or the Addons section on the Realmac Software Website. To share them you will need to locate 

them - RapidWeaver stores them here:

Code:

~/Library/Application Support/RapidWeaver/Snippets/

Find more Snippets
If you’re wanting to add some 

more snippets to your copy of 

RapidWeaver, why not visit our add-

ons page at:

http://www.realmacsoftware.com/

addons
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Page Types

RapidWeaver 4 ships with 10 built-in page types:

Page Types

Blog Publish your blog using RapidWeaver’s fully-fea-

tured blog page type.

Contact Form Receive visitor feedback and enquiries.

File Sharing Share files, photos and documents with friends, 

family and co-workers.

HTML If you’re happy to code individual pages in your 

site, you can do it with the HTML page type.

iFrame Display any external website within your own 

RapidWeaver-styled page.

Movie Album Allows you to share a gallery of QuickTime movies 

with visitors.

Offsite Page The Offsite page allows you insert external links 

into the navigation bar, for example a link to a 

forum.

Photo Album Easily build a CSS-based Gallery or a Flash Slide-

show with your iPhoto albums or other images.

QuickTime Add a single QuickTime movie to your site.

Styled Text Create your page content in a what-you-see-is-

what-you-get format. You have the ability to set 

font styles, change colours, drop-in images, mov-

ies and other files.
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Blog

The Blog page allows you to manage a collection of blog entries; recording personal events, thoughts, ideas 

and more. You may also add audio or video files to a blog entry to create Podcasts. All of these can be syndi-

cated using RSS feeds.

Adding an Entry

To add a new entry to your Blog, just click the [+] button located just below the blog entry list. 

The Post Settings area slides out from the right, where we can set up the catgories, tags and other information 

for this post. The time and date for the post is automatically set to the time you add the entry. However you 

can change the time or date by typing it directly into the time-and-date field, or set it to the current time and 

date by clicking the Clock button. Give your blog entry a title and then type your blog post in the Body box, 

located located in the lower half of the page. 

The post editing area is a full Styled Text area as found elsewhere in RapidWeaver, allowing you to format the  

text, and add links, HTML, movies and images. You may also use the Page Assets feature.

Smileys

In each blog entry you can use smileys just like in iChat. The Blog page style supports 8 different smiley emo-

tions. For example, entering :-) in your blog, RapidWeaver will convert it into a graphic.

Listed below are the smileys supported by RapidWeaver:

Smiley Text Equivalent

Smile :-)

Laugh :-D

Sad :-(

Wink ;-)
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Smiley Text Equivalent

Gasp :-o

Embarrassed :-[

Angry :-|

Foot-in-mouth :-!

Permalinks

A Permalink is a permanent link to a specific blog entry so that visitors may return to it even if it has been 

archived and moved off the main Blog page. When enabled in the General tab of the Blog’s Setup area, Rapid-

Weaver will automatically create a Permalink for each blog entry. If you’d like to create a custom Permalink 

for a specific blog entry, click the ‘Custom Permalink’ checkbox and type in a unique word or phrase (e.g. 

‘my_first_post’) into the Permalink field. When RapidWeaver publishes your blog page, it will create a Perma-

link based on the word or phrase you have entered.

Tip: RapidWeaver will automatically append the file extension (.html or .php) depending on 

what extension the page you’ve used in the Page Inspector.

Podcasting

RapidWeaver allows you to easily add Podcasts to your blog entries. Podcasting is a standard that allows au-

dio or video files (most commonly in MP3 or MP4 formats) to be published online in a way that allows Podcast 

capable applications such as iTunes to automatically subscribe to them and download the media for playback 

at the listener’s convenience.

When you add a Podcast to your blog entry by clicking the ‘Add Podcast...’ button, RapidWeaver presents a 

Podcast sheet (Figure 28) that allows you to drag-and-drop your Podcast media-file into your blog entry. The 

file needs to be in a QuickTime compatible format such as MP3 (audio) or MP4  (video and audio).  Once the 

media file is dragged in, you can specify custom tags, to help iTunes to correctly categorise your podcast. The 

custom iTunes tags (and subtitles) are controlled on an episode-by-episode basis using the iTunes Tags tab.  Adding an episodeFigure 28:
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For further information on iTunes Technical Specs, please visit the Apple website2:

Category: 

This is the category which iTunes should categorise the podcast under. It should be just a single category, such 

as Comedy or Technology.

Keywords: 

This allows you be more specific than a category. Think of them as tags, allowing you to refine the description 

of the episode -- so perhaps Mac, OS X, RapidWeaver would be considered Keywords of a Technology-centric 

show. Keywords should be comma and space separated.

e.g. Mac OS X, RapidWeaver, manual

Author: 

Simply enter your name, or the company name you wish to associate with the show. It will appear in the iTunes 

source list and over-ride the email address defined in the blog’s RSS setup.

Subtitle (Optional): 

Enter the subtitle you wish to show for the episode

Summary:

2 http://www.apple.com/itunes/store/podcaststechspecs.html

Over-riding the defaults
If you wish to refer to existing 

online content, do not drag in any 

media to the initial podcast drop-

box. Instead go to the ‘Custom 

RSS Tags’ tab and check the 

‘Over-ride default Podcast set-

tings’ option. Simply enter the full 

URL to the media (perhaps stored 

on a service such as Amazon S3 

or LibSyn).

Be sure to enter the full data for 

the size (in bytes) in the sizebox 

and specify the correct MIME type. 

Podcast ‘enclosures’ can be in the 

following formats: 

.mp3• 

.mp4• 

.m4a• 

.m4v• 

.mov• 

.pdf• 

 Configuring iTunes tags for a podcast episodeFigure 29:
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If you want to add more in-depth show notes specifically for iTunes, perhaps detailing the entire content of the 

show (such as topics covered, guest appearances, etc), you can enter it here.

Explicit:

iTunes allows you to ‘flag’ any content that may contain any explicit content (such as profanity). To flag this 

individual episode, simply check the ‘Explicit’ box for this episode.

Once you’re done with this episode, click OK. At the next publish, RapidWeaver will attach the correct files to 

the blog post, and publish the necessary enclosure tags for the post to ensure that podcast clients will know 

to download the episode from the server.

If you wish to edit the settings for an entire podcast, perhaps mark all episodes as Explicit by default, then 

the Advanced tab of the Blog plugin’s settings tab > iTunes can be edited to apply settings to the whole blog. 

You can also specify a custom show logo there, which will be displayed in iTunes as album art, and also in the 

iTunes Store if you submit your podcast there.

Blog Settings

Before you can syndicate your blog or broadcast your Podcasts, you must first configure your blog to use RSS 

feeds, set your default Podcast tags and customise your blog page’s options. Click the ‘Wrench’ icon below 

the Page List to show the Blog Settings.

The Blog Setup area has five main tabs:

General  Set Archiving, Permalink and Commenting op-

tions.

Categories  Enable and create blog categories.

RSS Feed  Configure the RSS feed for your Blog page.

Date Format  Configure the format of your time and date of 

blog posts.

Podcast  Set the default iTunes tags and Custom RSS 

Channel tags for your Podcasts.
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Ping  Enable weblog directory/tracking services to 

keep track of recent changes in your blog page.

When you first click the ‘Setup...’ button, the pane will default to the ‘General’ tab. Click the desired tab to 

expose the contents of its pane.

General Settings

The top section of the General tab (shown in Figure 30) contains the archiving options for your blog in which 

you can customise the archive behaviour, if used. By default, archiving is active. Disabling it will cause Rapid-

Weaver to keep all of your blog’s posts on the same page, growing longer with each blog entry you add. If 

enabled, archiving will move all your old posts to separate pages, keeping only the current week’s or month’s 

posts on the main page, as selected in the ‘Archive by’ popup menu. You can also set the minimum number 

of posts that must appear on the main blog page before older posts are archived, and whether or not to show 

gaps in the list of available archives.

The middle section of the General tab allows you to enable Permalinks in your blog and to set the Perma-

link’s link title. If you use summaries in your blog entries, you may choose whether the Permalink points to the 

summary rather than the blog entry itself by clicking the ‘Include Summary’ checkbox. When published, the 

Permalink will point to the summary, which will include a ‘Read more...’ link to the full blog entry. You may also 

change the ‘Read more...’ link’s wording by typing a word or phrase of your own choosing. This will become 

the system-wide link phrase when used in summaries in your blog.

The bottom portion of the General tab allows you to enable Comments in your blog entries, allowing visitors 

to post feedback for your blog posts. To enable blog comments, you must first sign up with Haloscan, a free 

comment-tracking service for bloggers. Once you have an account, enter your Haloscan username into the 

‘Username’ field and enable comment feeds by clicking the ‘Enable’ checkbox. If you want to change the 

name of the comment feed’s RSS link that appears in the sidebar, type it into the ‘RSS Link’ field. 

Once commenting is enabled, you will see ‘Comments (0) | Trackback (0)’ appear under each entry in your 

blog, and as comments and trackbacks are left by visitors, the number of comments will increase automati-

cally. By default a link labeled ‘Comments Feed’ will appear in the sidebar of your blog page allowing visitors 

to subscribe to an RSS feed of all the comments on your blog. You can prevent the link from appearing in your 

sidebar by removing the text from the ‘RSS Link’ box.

 General Blog SettingsFigure 30:
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Tip: You can manage your comments and the look of the pop-up-window by 

logging into the member’s area on Haloscan. Instructions on how to moderate 

comments, and more, can be found on the Haloscan website.

Categories

By default, categories are enabled in RapidWeaver allowing you to set a category or classification of your indi-

vidual blog entries. If categories are not desired, you may disable them by unchecking the ‘Enable’ checkbox. 

If enabled, you may also choose to display the number of blog entries in each category in the sidebar by click-

ing the ‘Show Post Count’ checkbox.

You can create additional categories for your blog by clicking the (+) button at the bottom of the categories list 

and typing the name of the new category. To remove a category, click on its name and click the (-) button. You 

may also arrange the categories in the list by clicking and dragging a category into a new position.

At the bottom of the Categories pane, you will find a Separator field. RapidWeaver uses the characters in this 

field to delineate the various blog entry details such as the date, category, and permalink elements (located 

below the blog entry’s title in your blog). The default separator is a ‘pipe’ delimiter (‘|’) with a space character 

before and after it for balance (e.g. ‘ | ‘), but you can use any character you wish.

Tags

Tags could be considered Sub-Categories, describing more accurately a blog post’s content. To enter a tag for 

a post, simply click in the tab box above the entry, type the Tag you wish to add, and hit Enter. The tag will turn 

to a ‘Token’ field and be applied to the post if tags are enabled.

 Catgeories SetupFigure 31:
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RSS

Almost every news website and blog allows users to subscribe to their content using a technology called RSS 

(Really Simple Syndication). RSS readers can help you keep up with all your favourite weblogs by checking 

their RSS feeds and displaying new items from each of them. NetNewsWire, Vienna and NewsFire are among 

the many popular news aggregators on the Mac, and Google Reader is a popular choice as an online news-

reader.

So that RSS news aggregators (including Podcast receivers such as iTunes) can subscribe to your blog page, 

you must enable RSS feeds for your RapidWeaver-created blog page. You may also configure your blog page 

so that it generates RSS entries only for the indvidual blog posts that appear on your main blog page, and not 

for any archived blog entries, by checking the box ‘Generate entries for main page only’.

You may specify how many words from each of your blog entries should be included in your RSS feed (from 

one to fifty words) by selecting the checkbox labelled ‘Summarise text in RSS Entries’ at the bottom of the 

pane, and moving the slider left or right as needed. The number of words will be shown to the right of the 

slider. If your blog entries use summaries, the number of words included in any blog entry’s RSS feed will be 

less than the length of the blog entry’s summary or the number of words set here.

 Configuring an RSS feedFigure 32:
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Advanced

Date Format

You can customise the way the date and time are shown by selecting the ‘Date Format’ tab in your Blog 

page’s ‘Setup...’ area. 

On this pane, you can specify how the date and time are displayed, including separators. As you make 

changes to the settings, an example is displayed in the lower portion of the pane. To localize the language to 

that of the one being used by your Macintosh, click the ‘Localize language’ checkbox.

iTunes

You may create default values for your iTunes tags and any custom RSS channel tags used in your Podcasts. 

The values entered here will become the default tags for all of your Podcasts, but you may override these 

values in any Podcast if desired by using the iTunes Tags and the Custom RSS Tags tabs in the Add Podcast 

pane.

When you click the ‘Podcast’ tab in your blog’s ‘Setup...’ area, two sub-tabs will be visible: ‘iTunes Tags’ and 

‘Custom RSS Channel Tags’. The default view is the ‘iTunes Tags’ sub-tab pane.

To set the default iTunes tags to be added to your Podcasts, click the ‘Enable Custom iTunes Tags’ checkbox 

and edit the fields on the Podcast: iTunes Tags pane. If you wish to add default custom RSS Channel tags to 

your Podcasts, click the ‘Custom RSS Channel Tags’ sub tab.

Channel

Use the Custom RSS Channel Tags sub-tab to add any tags not addressed using the iTunes Tags sub-pane, or 

to add any new Channel tags that may be added to iTunes in the future. As a rule, this should be unnecessary, 

but the ability to add custom RSS Channel tags remains available if needed.

Ping

As blogs have come into widespread use across the Internet, blog referral and tracking services have come 

into being. Companies like Technorati, Postami, BlogPulse and Google follow blogs and keep track of the 

most important stories being blogged about at the current time.

 Date date settingsFigure 33:

 iTunes Podcast settingsFigure 34:

 Blog ‘Ping’ settingsFigure 35:



49

Application Reference

You can configure your blog to ‘ping ‘these blog directory services every time your blog page is updated. To 

add a service to ping, click the (+) button, type the name of the service and the URL to its ‘ping’ page (the 

page on the service that accepts pings) and click the ‘Ping the following blog directories’ box. You can also 

send a ping immediately to any newly-added service by selecting its entry in the list and clicking the ‘Ping 

Now’ button.

Other

Movable Type Import

RapidWeaver allows you to import a Movable Type blog and bring the content into RapidWeaver. Clicking the 

import button allows you to point to a Movable Type export file and migrate your posts into RapidWeaver.

Dynamic PHP Sidebar

If you have got a lot of tags and categories, this will save you plenty of time. By taking advantage of PHP 

Includes, the sidebar is dynamically added, and there is no need to export each page every time the tag cloud 

changes. For those with large tag clouds, this will like reduce publishing time dramatically. This advanced fea-

ture requires a PHP-compatible host, and does not work on .Mac due to .Mac not supporting PHP.
 Advanced Blog SettingsFigure 36:
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Contact Form

The Contact Form page type lets visitors send messages and attachments to you via an easy-to-use form. You 

can completely customise the page to your specific requirements, including the use of checkboxes, radio but-

tons, text fields, pop-up menus and more.

The Contact Form requires PHP to be installed on your server. If you are unsure whether your server supports 

PHP, contact your hosting company before attempting to use the Contact Form page type.

Note:
Due to .Mac not supporting PHP, 

the Contact Form will not work 

with any site published to .Mac.

 Contact Form ViewFigure 37:
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The Contact Form supports six different types of page elements:

Element Description

Text Field Restricts visitors to typing a single line of text.

Text Area Allows visitors to type an unlimited amount of text.

Checkboxes Visitors select one or more the displayed options 

by clicking its box.

Popup Menus Visitors make a single selection from a defined 

popup menu.

Radio Buttons Visitors make a single selection from a list of op-

tions.

Attachments Allows visitors to attach a file to the form. Only 

one attachment is allowed per form.

Each element includes an option to make it a required item on the published form. If you require that visi-

tors must complete any given page element before the form can be submitted, click the element’s ‘Required’ 

checkbox. Unchecked elements on the form will not require visitors to complete them.

When visitors submit a completed Contact Form on your website, an email is sent to the address you have 

specified in the form’s setup page, containing the content of the form:

Entry Title Example Entry

Your Name Nik Fletcher

Your Email nik@california-roadtrip.com

Message Subject Visit Alcatraz!

Note:
Only one attachment is allowed 

per form.
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Entry Title Example Entry

Message I’d really recommend visiting Alcatraz.

When you add a Contact Form page, its form field list is initially pre-configured with four elements:

Element Description

Your Name Text field in which visitors to your site can type 

their names. 

Your Email Text field in which your visitors provide their email 

addresses. 

Subject Text field in which visitors enter the title of their 

message. 

Message Text area in which visitors type the body of their 

message to you.

To remove any of the existing elements, single-click on the list item and click the [-] button at the bottom of the 

list. To add a new field item to the form field list, click the [+] button. Type a label for the new field’s name and 

then select the desired field type. If the field must be completed by the visitor before the form can be submit-

ted, click the ‘Required’ checkbox.

Tip: When typing the field name for a newly-added element, use a delimiter like 

a colon (:) or a hyphen (–) to separate the label from the content provided by your 

visitors. Without a delimiter, the label and the content will be linked together in 

the message you receive.

Once you have added all of the elements required for your Contact Form page, you can re-arrange their order 

by dragging each element to the desired position in the list.

Popup Menus and Radio Buttons.
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If your Contact Form includes either a Popup Menu or Radio Buttons element, you should create a list of se-

lection values for each of them. By clicking on the name of the desired Popup Menu or Radio Buttons element 

in the form field list, the Popup/Radio Values list at the bottom of the Contact Form page becomes available.

To add the first selection value in the Popup/Radio Values list, click the [+] button below the list. The first line 

will be highlighted and the word ‘Name’ will appear in it. Double click the line to select it and type the first 

selection value. Repeat as needed to add all selection values. To remove a selection value, select it in the list 

and then click the [–] button.

Contact Form Setup

After setting up your Contact Form page, click ‘wrench’ icon beneath the Page List to change the settings for 

the contact form. The Page Inspector, as shown in Figure 38, will open and bring up a window such as the one 

shown to the left.

Setup Items Description

Send To: Enter the email address you want the form’s con-

tents to be sent to.

From Name: The form field you want to appear as the name of 

the person the email was sent from.

From Email: The form field that will contain the email address 

of the person the form was submitted by

Subject: The form field that will appear as the subject in 

any received any emails from the form.

Required Enter the message you want the form to display if 

a required field is left blank when submitting the 

form. Contact Form SettingsFigure 38:
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Setup Items Description

Symbol The symbol entered here to show on the form for 

required fields.

Submit Button The word(s) that appear on the button used to 

submit the form (default: ‘Submit’).

Reset Button The word(s) that appear on the button used to 

reset the form (default: ‘Reset’).

File Sharing

RapidWeaver includes a File Sharing page type that allows you to easily share files, URLs and documents with 

visitors to your website. You can either link to files on your Mac’s hard drive, or to files located elsewhere on 

the Internet.

The upper area of the File Sharing page displays a Files List window to which you add your files and URLs. 

The lower portion of the page contains a Page Description field. To add descriptive text for your published 

page, type the text in the Page Description field.

The Files List window is a series of rows, one row for each file or URL you add. Each row is divided into four 

fields: ‘Title’, ‘Description’, ‘Source’ and ‘Source Type’.

Sharing files

To add files to RapidWeaver’s File Sharing page, you may either drag them from a location on your hard drive 

and drop them into the File Sharing page, or use the (+) button to navigate to the file and select it. When you 

add a file to the list, its title will default to the file’s actual name (as seen in the Mac’s Finder). If you wish to use 

a different title for the file, double-click in the ‘Title’ field to change it. If desired, you may also add a descrip-

tion about the file in the adjacent ‘Description’ field. To change the list order of the files, you may click-and-

drag the files to arrange them in the preferred order.

Sharing URLs

To add URLs to RapidWeaver’s File Sharing page, click the (+) button to create a new entry in the list. Add a 

Tip:
Save space and reduce transfer 

times, by compressing large files 

you want to share. Simply Control-

click (or right-click) the file you 

want to compress and choose 

“Compress FILE_NAME” from the 

contextual menu that appears.

 Contact Form Settings  Figure 39:
Customisable Form Messages
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title and a description to the new entry and then change the ‘Source Type’ dop-down list option to ‘External 

URL’. Finally, double-click into the ‘Source’ field and type the full URL you want to use. As with files, you may 

arrange their order in the list by clicking and dragging them do the desired positions.

Tip: You can use the File Sharing page type to create a “Favorite Links” page on 

your website. Just use the tips for “Sharing URLs” outlined above.
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HTML

The HTML page type allows you to hand-code your page content in a mono-spaced code editing view. If you 

want to create an HTML page that retains the theme of the other pages in your website, leave the ‘Don’t apply 

theme’ checkbox located in the ‘Page’ tab of the Page Inspector unselected. Unticking this box will remove all 

the theme layout from the page, giving you an entirely blank canvas to start from scratch.

Tip: You can enter anything into the HTML page type, including Javascript, CSS, 

PHP and more. Just remember that the page’s extension needs to reflect the 

content on the page, so be sure to check that the Page Inspector has been set 

up correctly.

 The HTML PageFigure 40:
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iFrame

To display an external site within a page on your own website, select the iFrame page style. The iFrame is sup-

ported by most modern browsers.

The iFrame page style creates an inline frame that contains another document. For example, you could use it 

to display another website within your own website or perhaps a support forum.

Once you have entered a URL to display in the Page Inspector, you can set the width and height of the frame 

in which it is displayed as well as the iFrame’s border attributes.

Movie Album

Share your movies with friends, family and co-workers. Simply drag the movies you want to publish on your 

website to the movie list.

You can change the order of your movies by dragging them to the desired position. To change a movie’s cap-

tion, double-click on the movie’s existing file name or title in the Caption field. Basic HTML text-formatting tags 

are supported within the Caption field, if desired.

Tip: Movies must be in a QuickTime-supported format, e.g. MP4, MOV.

Album Setup

To give your movie album a title and description, and to set the AutoPlay option, click on the ‘Album Setup’ 

button in the lower part of the screen.

Autoplay Movies: 

Selecting this option will start the movie automatically when the user opens a movie window.

Selecting a Thumbnail image: 

RapidWeaver will automatically select a thumbnail from a point midway through the movie because many mov-

ies start with a black screen. If you’d like to select the thumbnail image from a different position in the movie, 
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double-click on the movie thumbnail in the list to bring up the thumbnail selection sheet. Select a frame in the 

movie you want to use as the movie’s thumbnail and click the ‘Set’ button.

Offsite Page

Using an Offsite page style will allow you to redirect visitors to external URL’s from a navigation button or link 

on our website, rather than showing their content inside an iFrame on your own site. This is useful if you have 

a page that isn’t created in RapidWeaver, a friend’s website, an affiliate, or some other external website to 

which you want to direct your visitors to from the navigation menu.

Using the Page Inspector, you can configure the Offsite Page to add external links to your navigation menu. 

Links can open in the same window, or a new window by configuring the ‘page’ to do so in the ‘General’ tab of 

the Page Inspector.
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Photo Album

The Photo Album page type allows you to share your personal photos with friends and family on your website. 

RapidWeaver reads your iPhoto Albums to allow you to quickly build online galleries from them, or you can 

drap in photos manually (either from the Finder or iMedia Browser).

Using iPhoto Albums

iPhoto albums are listed in the left-hand column. To use one of the iPhoto Albums on your website, highlight 

the desired album in the list. You may add a description about the iPhoto album that will displayed on the pub-

lished page by typing into the album description box located below the iPhoto albums list.

When you select an iPhoto album from the list, thumbnails for each photo in the iPhoto album will appear in 

the thumbnails list on the right along with its associated file name from iPhoto. To arrange the viewing order of 

 iPhoto Album IntegrationFigure 41:
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your photos, click on a thumbnail and drag it to the desired position in the thumbnails list.

By default, all photos will be selected for publishing when you choose an iPhoto album, but you can use the 

checkboxes that precede each thumbnail in the list to select which ones should be published on your website. 

To disable all photos in the list, select all the images in the album and then choose bottom of the Photo Album 

page; to select all photos in the list, click the solid checkmark.

When published, the selected photos will display the file name of the image as listed in iPhoto, but you can 

over-ride the filename with a caption of your choosing by double-clicking and typing into in the ‘Caption’ field 

of the selected photo in the thumbnails list.

Creating Custom Photo Albums

You may also use photos or images located elsewhere on your hard drive to create a custom Photo Album 

page. Begin by clicking into the textbox located above the iPhoto albums list and typing a name for your 

custom album. Once you have chosen a name, simply drag-and-drop photos from your hard dirve into the 

thumbnails list, or use the (+) button located near the bottom of the window to navigate to the photos on 

your hard drive. You may arrange the viewing order by dragging the thumbnails to the desired position in the 

thumbnails list.

After you have added your photos, you can add a description for your custom photo album in the album 

description box located below the iPhoto albums list. As with iPhoto album photos, the published photos will 

display their respective file names when published, but you may override this by typing new captions in the 

‘Caption’ field of any selected photo.
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Photo Album Setup Options

Before publishing your Photo Album page, click the ‘Setup’ button in the lower right corner to configure pub-

lishing options. When you click the ‘Setup’ button, the Photo Album Setup sub-tab in the Page Inspector will 

appear, defaulting to the ‘General’ tab.

General

Use Flash Slideshow: 

This allows you to specify whether to create a pure HTML gallery or a Flash slideshow. If you wish to use the 

Flash slideshow, tick the box and proceed to the Flash Slideshow tab to configure it.

Captions: 

You can specify whether your photos’ captions should be displayed below each thumbnail, below each full-

size photo, or not at all. To make your selection, choose one of the four options in the ‘Captions’ drop-down 

list.

Thumbnail Size: 

Use the slider to set the size of the thumbnails to be shown on your Photo Album page. Based upon the se-

lected size, RapidWeaver will automatically determine the number of thumbnails to be displayed in a row, and 

the spacing between them. Use smaller thumbnail sizes to maximise the number shown per row.

Image Quality: 

Specify the quality of the photos being published by selecting ‘Best’, ‘High’, ‘Medium’ or ‘Low’ from the 

Compression drop-down list. Higher quality photos will look better, but will take longer to download. If you are 

scaling your photos down from their original sizes, you may also specify whether to use High-Quality Scaling 

by selecting the indicated checkbox to reduce pixelation and other photo-resizing artifacts (recommended).

 Photo Album SettingsFigure 42:
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Tip: For best results, pre-size your photos to the exact dimensions you 

wish them to be viewed on your website using your preferred photo-editing 

application. Set the Compression to ‘Best’ from the drop-down list and un-check 

the “Use this size” checkbox in the Image Size portion of the General pane. This 

will result in no compression or resizing of your photos whatsoever.

Scale Image: 

By default, photos are constrained to a maximum width of 640 pixels and a maximum height of 480 pixels. 

RapidWeaver will not adjust the aspect-ratio of the images, but no photo will exceed a width of 640 pixels, or a 

height of 480 pixels. You can specify different maximums by typing in different values. If you uncheck the ‘Use 

this size’ box, RapidWeaver will not constrain your photos at all. Instead, your photos will be published in the 

exact dimensions of your originals, which will increase load times when using large images.

Navigation: 

Here you can set the labels for the navigation links in your Photo Album pages. Visitors to your website can 

navigate through your photos using the text links on the published photo pages. By default, these links are 

labeled ‘Previous’, ‘Home’ and ‘Next’. You can customise these links by changing the content of their corre-

sponding fields. This is especially useful when publishing your photo album in a language other than English.
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Flash Slideshow

Slideshow Interface Options

Display - Controls: 

This will toggle the Flash slideshow’s navigational controls on and off.

Display - Info: 

This will toggle whether to show additional information about each photo.

Display - Loading Icon: 

If you do not wish to show the animated loading icon, untick this box.

Activate on Rollover: 

Choose whether the slideshow should activate when a users mouse cursor rolls over the slideshow.

Flickr RSS: 

With RapidWeaver 3.6, you can specify a Flickr RSS feed for photos you wish to slideshow. Simply enable this 

box, and paste in a Flickr RSS feed to show the pictures from that feed in the Slideshow.

Slideshow Size: 

Configure the slideshow size to suit your page’s needs, and specify a background colour.

Visual Effects Options

Transition: 

To choose which transition is used, simply select one from the drop down menu, and if required, a transition 

duration (in seconds) in the box to the right.

Scale Image: 

Configure the scaling of slideshow images, by choosing to scale the images as desired.

 Configuring the built-in Figure 43:
Flash Slideshow
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Link to large images: 

Allows you to specify whether, on clicking a slideshow image, the large image should open in a new window.

Image Pause: 

Set the duration of each image’s appearance on-screen by entering a time (in seconds) here.

Ken Burns: 

The Ken Burns effect (often used in iPhoto slideshows) is available as part of the Flash Slideshow. You can 

turn it on (and specify a type of effect) or turn it off via this drop-down.

Variation: 

This sets the intensity of the zoom within the Ken Burns effect. Dragging to the left uses less zoom, whilst 

dragging to the right will create a more extreme zoom in, as part of the Ken Burns effect.

EXIF

When creating a CSS-based gallery, you can also choose to display EXIF metadata such as the ISO Speed, 

Aperture, or Shutter Speed the photo was taken at. To enable EXIF data, simply check the ‘Display EXIF Data’ 

checkbox, and select the EXIF data options you want to show on photo pages.

Note: EXIF data is only shown if the CSS-based gallery is used, and is displayed 

on the individual photo pages.

 EXIF display optionsFigure 44:
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Advanced

The ‘Advanced’ tab in the Setup sub-tab includes options that allow you to manage the Photo Album pages 

photo cache, enable support for multi-processor Macs and import comments from iPhoto.

Photo Cache: 

Enabling the Photo Cache in RapidWeaver will dramatically improve refresh times when switching between 

‘Edit’ and ‘Preview’ modes, and when exporting or publishing your website. It is recommended that you leave 

the Photo Cache option enabled. Click the ‘Clear’ button to reset your Photo Album page’s cache.

Tip: If you have previously published or exported your Photo Album page, and 

subsequently make changes such as disabling, adding or removing photos 

- or you re-arrange the order of your photos in the thumbnails list - you may 

sometimes find that the exported / published results aren’t what you expected. 

To correct this, click the “Clear” button in the Photo Cache section and re-export 

/ re-publish your Photo Album.

Multi-Processor Support: 

To speed the processing of your photos when being exported by RapidWeaver, owners of multi-processor 

Macs may enable multi-processor support by clicking the designated checkbox. Leaving this box checked will 

not result in any processing benefits on single-processor Macs.

Import iPhoto Comments: 

If you are using an iPhoto album as the source for your Photo Album page and you want to use the comments 

you have created for your photos in the selected iPhoto album, clicking the ‘Import Comments’ button in the 

Advanced sub-tab will retrieve the existing comments. Be aware that this will overwrite any custom captions 

you have created previously.

 Advanced SettingsFigure 45:



66

Application Reference

QuickTime

Share your movies with friends, family and co-workers. Movies should be in QuickTime-supported formats 

such as MOV, AVI or MPEG. To add a movie to the QuickTime page, click the ‘Choose Movie...’ button, navi-

gate to the movie you want to use, select it and then click the ‘Open’ button.

Add comments or descriptive text by typing in the text box at the bottom of the page. The text box supports 

styled text and all other formatting supported by the Styled Text page.

AutoPlay Movie: 

Checking the ‘Autoplay Movie’ box will cause the movie to automatically play when a visitor selects the Quick-

Time page on your website.
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Styled Text

The Styled Text page type is the most widely-used page style in RapidWeaver. A Styled Text page allows you 

to quickly create a page with styled text, images and movies without requiring any knowledge of HTML. How-

ever, you may also use HTML to extend the capabilities of the page, if desired. Use the Format menu to apply 

font and style changes to your selected text, or to apply commonly-used HTML options. To add an image, file 

or movie, simply drag it from the Finder into the content area.

The content area of of the Styled Text page type supports the following:

Media Supported

Text Styled and Plain

Images PNG, GIF or JPEG

Movies QuickTime, Quicktime VR

Files .zip, .pdf, .sit, etc...

Styling text

You can style your text by using the Format menu located in the menu bar. If you have used a word processor 

or TextEdit, then styling text in RapidWeaver should already be familiar to you. Type or paste your content into 

your page under the Edit tab, select the desired text with your mouse, and choose the appropriate formatting 

options from the Format menu.

Using the options found under the Format menu, you are able to control the appearance of the content on your 

pages. RapidWeaver offers only those fonts considered to be ‘web safe’ to ensure that your website’s appear-

ance is consistent in all common browsers.
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Tip: RapidWeaver actually applies a list of fonts to the text you are styling, so 

you can be sure that if a visitor doesn’t have the same font installed, the next 

most-similar font available in the list will be used. For example, should you use 

Arial for your text, RapidWeaver will apply the following font list: “Arial, Verdana, 

Helvetica, Sans-serif”. If the visitor doesn’t have the primary font installed (Arial, 

in this case), then the list tells the visitor’s browser to use the next available font.

Adding images

To add an image to your page, drag it from the Finder into the desired location in the content area. Supported 

image file formats are PNG, GIF or JPEG. Other image file formats will appear as embedded links in the pub-

lished page.

Images that have been added to a Styled Text page may be further refined by using the Media Inspector, al-

lowing you to scale the image, rotate it, add a border or shadow effects and more.

Adding movies

To add a QuickTime movie to your page, drag it from the Finder to the desired location in the content area. A 

dialog box will appear asking ‘Do you really want to copy the contents of the dragged items into the text?’, 

and displaying three buttons: Alias, Copy and Cancel.

Clicking the ‘Alias’ button causes RapidWeaver to link to the QuickTime movie file externally on your hard 

drive. This results in a smaller project file, but if the movie is subsequently moved to another location on your 

hard drive - or deleted altogether - the link to the movie will be broken the next time you open your project file. 

If you intend to alias your QuickTime movies in your Styled Text pages, consider creating a permanent location 

on your hard drive for your website’s source files, and add your QuickTime movies to your Styled Text page by 

dragging them from that location.

There are other advantages to aliasing your QuickTime movies. For example, if you choose to edit the movie 

after you have published your website, you can revise the movie independently. As long as the revised version 

resides in the same location on your hard drive as the original and retains the same name, the new movie will 

be used the next time you change the page that contains it (or you have marked the page as ‘Changed’).
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Clicking the ‘Copy’ button causes your QuickTime movie file to be copied directly into your Styled Text page. 

This will result in a larger project file, but if you move the original movie to another location, it will not affect 

subsequent uploads of your website.

Note: Only QuickTime-compatible may be added to Styled Text pages as 

described above, and will be automatically centered on the page. Other movie 

formats may be added manually through HTML code.

Making text flow around images

After placing an image at the beginning of the text you want flowed along its side, highlight the image and 

select ‘Align Image Left’ or ‘Align Image Right’ from the Format > HTML menu option. Click the Preview tab to 

see how the text flows around your image and adjust as necessary. 

You can also use the Formatting bar at the bottom of any Styled Text area to quickly access the HTML menu. If 

you’re happy using HTML code <div class> tags:

Code:

<div class=“image-left”>Place Image Here</div>

<div class=“image-right”>Place Image Here</div>

Adding links to text and images

To add an email address or URL to text or an image, highlight it and press the ‘Add Link’ button at the lower 

part of the screen.

A dialog box will appear allowing you to either select another page in your RapidWeaver project to which the 

text or image should be linked, or to specify an email address or URL of a page on another site. If you have 

added an item in the Page Assets tab of the Page Inspector, you will also be able to link to an asset in the list. 

Once you have selected the target of the link, you may specify whether the linked item should open in the cur-

rent window, or in a new window.

Tip:
If you wish to link to an image, 

instead of showing it on the page, 

add it to the page’s Assets and 

create a link to it using the “Add 

Link” button. For more information 

about adding a link to your text see 

Adding links to text and images 

later in this section.

 Adding a LinkFigure 46:
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Adding file downloads

Drag and drop a file such as a PDF, ZIP, DOC or other file type to the desired location of the content area to 

automatically create a link to it in your published page. Visitors will be able to click the link and download it.

Mixing HTML or Javascript with styled text

You can include HTML or Javascript code in a Styled Text page, but unless you mark the block of code prop-

erly, RapidWeaver will not render it correctly. To mark a block of code so that RapidWeaver not affect it, select 

the block and choose ‘Ignore Formatting’ from the Format menu, or from the HTML menu below any Styled 

Text page or Blog post.

You can also wrap text around you have pasted in the content area by selecting the image and choose ‘Align 

Image Left’. To make a portion of text stand out, select the text and choose ‘Blockquote’ from the HTML sub-

menu. This will apply HTML tags to the code, and will be displayed as selected when Previewing the site.

Pasting text

Text copied from another text editor or word processor may be pasted directly into a Styled Text page, but 

such text may include fonts or formatting that aren’t web-safe. The pasted text will look fine when viewed 

on your computer, but when viewed by other visitors who come to your site, the pasted text may not render 

cleanly.

To avoid this when using text copied from another document, hold down the Option key and select ‘Paste as 

Plain Text’ from the Edit menu. The copied text will be inserted as plain text, which can then be formatted as 

needed using the formatting tools within RapidWeaver.

Note:
If you’re pasting from an application 

such as Microsoft Word, we recom-

mend you use the ‘Paste as Plain 

Text’ option.

Due to the way Word places format-

ted text in the clipboard if you do 

paste content ‘as-is’ from Word it 

may not render accurately.
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Publishing

RapidWeaver allows you to publish your site locally, to a .Mac account or to a webserver. It also allows you to 

publish and export just the pages that have been updated. If you don’t have a .Mac account you can sign up 

for one at Apple’s .Mac website.

Tip: To re-upload everything to your webhost, choose the ‘Re-Publish All Files’ 

option from the File menu.

Publishing via FTP

RapidWeaver allows you to publish sites directly to a webserver using the built-in FTP (File Transfer Protocol) 

client. To publish your site using FTP, you will need to provide four things: the server’s URL or IP address, your 

account’s Username and Password, and your webserver’s Site Path (directory) to which you must publish your 

website’s contents. If you are uncertain about any of these points, contact your hosting provider before you 

attempt to publish your site. Click the ‘Publish’ button on the main toolbar, and choose FTP from the 

 Publishing ViewFigure 47:



72

Application Reference

Server: 

The name or IP address of your webserver. The name is often the domain name of your website (e.g., ‘MyDo-

main.com’), but may also be an explicit server name provided to you by your webhost. This varies from one 

webhost to the next, so check with your hosting provider if you’re not sure which settings to use.

User Name: 

This is the username required by your webhost to log into your web publishing account.

Password: 

This is the password required by your webhost to log into your web publishing account.

Save in Keychain: 

Check this box if you want your Mac to securely remember your login password for future publishing.

Site Path: 

This is the path to your website’s publishing directory on the webserver. This varies from one webhost to the 

next, but commonly-used site paths include ‘/’, ‘/www/’, and ‘/public_html/’ (without quotes). If you are unsure, 

contact your webhost or ask on the RapidWeaver forum.

Passive Mode: 

Selected by default, most webservers use this transfer option. Deselect this option only if your webserver 

requires active file transfer.

Log in Anonymously: 

Whilst rarely used, selecting this option will tell RapidWeaver to attempt to log into your webserver without a 

username or password.

Advanced Settings

The Advanced settings box (Figure 48) allows you to enable and configure Secure FTP (SFTP) file transfers and 

other settings.

 Advanced FTP SettingsFigure 48:
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Publishing with .Mac

RapidWeaver includes built-in support to publish to your RapidWeaver website on your existing account on 

.Mac. If you already have .Mac setup correctly in the System Preferences, RapidWeaver will automatically use 

these as defaults when publishing.

User Name: 

If you are not using your .Mac System Preferences settings, type your .Mac Username in this field.

Password: 

If you are not using your .Mac System Preferences settings, this is the password required by .Mac to log into 

your account.

Site Path: 

This is the directory to which you are publishing your website on your .Mac account.

Use Default Account: 

Selecting this option tells RapidWeaver to use the login credentials stored in your .Mac System Preferences, 

overriding the User Name and Password fields entered in this sheet.

Publish to subfolder of Sites Folder: 

Selected by default, this allows you to publish to a subdirectory of your Sites folder in your .Mac account. For 

example, specifying ‘My Website’ in the Site Path will cause RapidWeaver to publish to a path http://homep-

age.mac.com/YOUR_ACCOUNT/. If not selected, RapidWeaver will publish directly to your ‘Sites’ directory on 

your .Mac account.

Use .Mac Personal Domain

If you have configured your .Mac account to host a personal domain, RapidWeaver will upload to the correct 

location for the personal domain when this box is ticked. For further information on setting up .Mac Personal 

Domains, please visi the .Mac Help Centre3.

3 http://help.apple.com/mac2/1/help/member/pgs2/mem_fmset_gen367.html
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Preferences

You can access the Preferences window from the RapidWeaver menu. RapidWeaver > Preferences.

General

When RapidWeaver Launches

These options allow you to configure RapidWeaver to do nothing, prompt you to choose a document to work 

with, open your last project or create a new project when launching the application.

Show News Window

If you do not wish to see the RapidWeaver News Window on startup, uncheck this option.

Use Large Icons for webpage list

This option allows you to choose whether the webpage list uses small or large icons.

Publishing

Clear Publishing Flags When

Allows you to specify when RapidWeaver should mark a page as unchanged: after publishingor exporting it,

When Exporting

These settings determine what RapidWeaver does when exporting your site to a local folder: whether it should 

delete an existing folder before exporting, and whether it should open your exported site in the selected 

browser.

Enable Smart Publishing

If, for whatever reason, you can turn off smart publishing for all projects by unchecking this box.

Consolidate Common Files

RapidWeaver will, by default, only upload one set of ‘common’ (theme) files to your server and reference them. 

Unchecking this option will uplod a copy of the theme files for each page in your project.

Use NcFTP Framework

If you are having issues publishing, this option will switch to an alternative FTP framework.

 General PreferencesFigure 49:

Publishing SettingsFigure 50:
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RapidWeaver Add-ons

RapidWeaver has a very powerful and open architecture allowing third parties to develop add-ons for the ap-

plication. At the last count, there were over 300 third-party addons available for RapidWeaver. In version 4 you 

can now purchase add-ons from within the application, through the ‘Store’ menu.

Installing Add-ons

All RapidWeaver add-ons are stored in the RapidWeaver Application Support folder, located at:

~/Library/Application Support/RapidWeaver/

To install an add-on, drag it into the corresponding support folder -- always ensure you have quit RapidWeaver 

before installing any addons. You can also double click Themes and Page Types to install them. RapidWeaver 

will launch and install them. Simply restart the application in order to use them,

Themes and Page Types should go in the main RapidWeaver application support folder however Theme Styles 

and Snippets must go into the correct folders shown below in order to be found:

Add-on Name Extention File Path

Page Types .rwplugin ~/Library/Application Support/

RapidWeaver

Themes .rwtheme ~/Library/Application Support/

RapidWeaver/

Theme Styles .rwstyle ~/Library/Application Support/

RapidWeaver/Theme Styles

Snippets .rwsnippet ~/Library/Application Support/

RapidWeaver/Snippets
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Page Types

Page Types add additional page styles and functionality to RapidWeaver. You can find more page types by 

either opening the RapidWeaver Store that’s built into RapidWeaver 4 (found under the Store menu) or 

Themes

The list of theme companies is constantly growing, this means you get to choose from hundreds of extra 

themes. Themes are listed on the Realmac Software Add-ons website, however Realmac Software does not 

offer support for 3rd party themes. Please contact each developer for support.

Theme Styles

Theme Styles are ways of grouping selected Theme Variations. Themes can ship with Theme Styles built in, 

they can be made available separately, and the user can create their own within RapidWeaver.

Snippets

Snippets are code fragments that you may use regularly or simply wish to store for future use.

Tip:
The official themes and plugins 

that ship with RapidWeaver are 

stored within the application itself.

You can show the default themes 

by choosing the ‘Show Official 

Themes in Finder’ option from the 

Theme Browser’s Folder menu.
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Advanced Features

Image Normalisation

We added Image Normalisation because we found we had many customers with files over 200MB who were 

dragging and dropping 10MB digital pictures pictures directly inside Styled Text areas, and then scaling it to 

5% or 10% of its original size.  Users did not realise that RapidWeaver was saving the entire original image in 

the RapidWeaver save file.

Image Normalisation is highly recommended for very large (150MB+) RapidWeaver documents, otherwise the 

performance and stability of your system may be degraded. 

Image Normalisation works by taking images that you have scaled down to smaller sizes yourself and stores 

that smaller image in the RapidWeaver document file that’s saved to disk. So, if you have a 3000x3000 image 

and scale that to 10% of its original size via the Media Inspector, the resulting file that’s saved in the site file is 

300x300. This does not result in any loss in quality of the published image, although it does result in you not 

being able back to ‘upscale’ the image to its original size (thus the large warning when you run it).

Image Normalisation is an irreversible operation. It does not affect the final look and feel of your web site, but 

if you have very large images that you have rescaled to, for example, 10% of their original size, you will not be 

able to upscale those images to be larger after Normalisation. 

 Image NormalisationFigure 51:



78

Application Reference



79

RapidWeaver Tutorials



80

RapidWeaver Tutorials



81

RapidWeaver Tutorials

Google Analytics

One of the most frequently asked questions is ‘How can I find out about who’s visiting my website?’. Google 

Analytics is one of the most powerful tools around for gathering information about your website’s visitors - and 

best of all, it’s free to use on your site. Whilst we’re not going to look at the features of Analytics, instead we’re 

to look at how to integrate the Analytics system’s tracking code into your RapidWeaver-built site, but if you want 

to find out more, be sure to check out the Google Analytics site.

If you don’t already have one, sign up for a Google Analytics account at:

 

https://www.google.com/analytics/ 

Login to your Google Analytics account and Click the ‘+ Add Website’ Profile button - you will need to add a new 

profile for each website you want to track. After following the 3 step sign-up you will arrive at a screen similar to 

that shown in Figure 52 to reflect that we’ve added a profile for our own site.

 Google Analytics Profile PageFigure 52:
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Getting the tracking code for your website

Now we have added a profile for your website, click the ‘Check Status’ to retrieve the tracking code for your 

site. You should tab entitled ‘New Tracking Code (ga.js)’ on the next page. Click that tab, and copy the code 

displayed [very similar to that shown below] to the OS X clipboard.

Code:

<script type=”text/javascript”>

var gaJsHost = ((“https:” == document.location.protocol) ? “https://ssl.” : 

“http://www.”);

document.write(unescape(“%3Cscript src=’” + gaJsHost + “google-analytics.com/

ga.js’ type=’text/javascript’%3E%3C/script%3E”));

</script>

<script type=”text/javascript”>

var pageTracker = _gat._getTracker(“UA-xxxxxx-xx”);

pageTracker._initData();

pageTracker._trackPageview();

</script>

Now that we have the code we need to track visitors, return to RapidWeaver and open the Site Setup sheet 

through the Setup item on the main toolbar, or use keyboard shortcut Cmd + 1, and go to the ‘Advanced’ tab. 

Enter the tracking code in the Google Analytics box.

After this tutorial, you will need to re-publish the entire site to get the code to be placed on every single page. 

To do this, simply click ‘Publish’ after inserting the code. As all your pages will be marked as changed, Rapid-

Weaver’s Smart Publishing will upload all the pages in your site.

 Entering Google       Figure 53:
Analytics Code
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Inserting a Lightbox into RapidWeaver

This tutorial will guide you through the steps required to add a lightbox effect to your RapidWeaver site. Be sure 

to have downloaded the Lightbox files available from the Realmac Software website.

Tip: this tutorial uses the Slimbox variant of lightbox which runs on the Mootools 

framework. It’s just a editorial preference due to the versions simplicity and 

small file size. If this means nothing to you don’t worry, all the required files are 

available for download. The result is the same as most of the the other lightbox 

variants.

Step 1

First you need to include the slimbox files in your theme directory. These are available from the Realmac Soft-

ware website4. Ctrl-click on the theme within the RapidWeaver theme browser and select ‘Show contents’. 

Unzip the slimbox.zip file. Drag the unzipped slimbox folder into the ‘CSS’ folder listed in the Theme’s contents. 

You may be wondering why we drop it into the CSS folder. This is because if you put it into the theme directory 

RapidWeaver will not upload it. You could add the folder to the .plist but that may make things a unnecessarily 

complicated for most users.

Step 2 

Next you need to add the javascript files to the page you want to use the effect on. The following code should 

then be inserted into the CSS sub-tab of Header area of the Page Inspector (cmd + shft + i).

4 http://www.realmacsoftware.com/downloads/manual/slimbox.zip



84

RapidWeaver Tutorials

Code:

<script type=”text/javascript” src=”%pathto(css/slimbox/js/mootools.

js)%”></script>

<script type=”text/javascript” src=”%pathto(css/slimbox/js/slimbox.

js)%”></script>

<link rel=”stylesheet” type=”text/css” media=”screen” 

href=”%pathto(css/slimbox/css/slimbox.css)%”  />

Step 3

In order to link the thumbnails to the full size images you need to drag and drop the full size images into the page 

assets area found under the ‘Header’ tab of the Page Inspector.

To launch the javascript add a link to the thumbnail image or text link you want to open the lightbox. The Rapid-

Weaver link options will then drop down, there are several aspects of the lightbox that can be configured here.

Select the image you want to open from ‘assets’ in the drop down.  Expand the ‘Custom Attributes’ area of the 

Add Link sheet. Any text entered into the title input will display as a caption inside the lighbox window.  Next, 

add a new row to the ‘Custom Attributes’ area and replace ‘key’ with ‘rel’ and replace ‘value’ (in the right hand 

column) with ‘lightbox’.

To group several images together to form a basic slideshow in the lightbox, just add square brackets after light-

box in the rel input with the group name inside. e.g. lightbox[group]

All images with the same group name will be linked together as an album within the lightbox.

Step 4

To add more images you can either add links to further thumbnails or text links as in Step 3. Alternatively you can 

put blank links (links with no text in between the tags) in a styled text page, for example:
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Code:

<a href=”assets/(...image_name.jpg...)” title=”caption” 

rel=”slimbox[group]”>

These links will not show up on the page but you can click next inside the lightbox to move through them. This is 

not really advisable because anyone viewing our site without javascript enabled would have no way of accessing 

the images. It is always good practice to include visible links to all content on your page.
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Search Engine Optimisation

No matter what type of website you’re creating in RapidWeaver, you will probably want the content to be 

findable via a search engine such as Google or Yahoo. RapidWeaver does offer support for Search Engine 

Optimisation (SEO) both when it automatically generates your site content, as well as through the user entering 

details in the application.

We’ve also got a few basic tips to ensure your site is as readily optimised for Google indexing (and thus key-

word searching). These website marketing strategies are intended mainly for small or home based businesses, 

though they are just as relevant for anyone that wants to build traffic, visitors or make money with their website 

or blog.

1) Do your keyword research. Many people think they can shortcut the system by just using the free versions 

of keyword research tools. Guess what, you get free results, the same results everybody else is getting! To get 

to the effective keywords with little competition you have to dig deep into the keyword databases. The top 

100-150 is not going to mine data deep enough most of the time.

2) Have an active website. Keep writing more and more content tweaked to meet the needs of the people 

searching for you. Out of new ideas? If you have given your visitors a way to contact you they will ask ques-

tions. Instead of writing the answer just to that person, (you are answering them aren’t you?) make a new web 

page with the answer. Your customers are your greatest asset in helping you build new content.

3) Make your internal and outgoing links count. There is a marketing method called siloing or themeing. Let me 

explain. Use the example of the ‘classic car restoration tips’ There may be pages about painting, sanding and 

blocking, parts, repairs, upholstery and on the list goes. Each of those become a theme.

The first page in the silo is a good anchor page that covers all the aspects of that theme. For instance lets use 

upholstery. Use one page to ‘introduce’ each concept of upholstery repair, classic car seat covers, upholstery 

leather, upholstery stitching, upholstery colours, upholstery texture, upholstery suede, upholstery vinyl, etc. 

Once you have the anchor page complete then use that as your mini marketing plan for that silo/theme.

Simply build 5-15 new web pages, again using our SEM strategy of optimising for the relevant keyword, and 

link to each of them from the anchor theme page. Don’t link to anything else unless it has to do with that 

theme and that theme only.

4) Clear and accurate site map. A sitemap is like a table of contents in a book or journal. One of the simplest 
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search engine strategies is to make a great sitemap. Sometimes, like this website, there are more then one. I 

make one for each silo/theme that I build. Using this SEO method the visitor gets to see all the information that 

is available within that theme/silo topic. They don’t get lost or sidetracked by other links or ‘noisey clutter.’ The 

main search engines, Google, Yahoo, MSN and Ask all accept another kind of site map that your visitors can-

not see. With RapidWeaver both kinds can be made for you automatically.

5) Create a marketing buzz Building a business online and offline is not that much different, just different tools. 

Create anchor content people would want to share with others. This is the same anchor page I described 

above. I single this out because so many do not invest the time to research and build this page. If you don’t 

learn anything else learn anchor content and silos.

learning seo

This anchor content is critical in any SEM strategy. It is the beginning of your silo/theme. It is the page that 

all pagerank will be given to. It is the web page that visitors whill look at and decide if the rest of the website 

might be worth looking at.

6) Allow visitors to participate in the discussion. After you have built 30-40 pages allow your visitors to submit 

questions and comments even small articles to you. Let them know that you may want to post a comment or 

make a webpage of the content they share with you. More free content, all you have to do is check for possible 

spelling errors and obvious grammatical mistakes. Just make sure the tone and meaning is not disturbed. This 

is a great way to build friendly and loyal customers.

7) Be Patient! Be Consistent! A good SEO strategy is persistent hard work and takes time to produce results, 

however the results endure and are less expensive then other marketing methods.

Congratulations, now that you have this process in your head just repeat the process for each new niche you 

want to build.

Here is a tip, you can either repeat the process and make several websites in different niches or you can re-

ally build one great niche website. The bigger you build a single website the more stable it becomes. As your 

website grows you will begin to beat the competition for even more broad search terms. As you gain authority 

on your niche you will be able to expand into additional related niches. Just make sure you are very entrenched 

in your current niche before expanding out.
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Re-Publishing Your Entire Site

If you have uploaded your site, but some files appear to be missing -- or the theme you have chosen is not ap-

pearing -- you will need to over-ride the built-in Smart Publishing and upload every file in your site again. This 

is also important if you move the location of your site, due to a hosting change or a simple directory change.

Because RapidWeaver uses Smart Publishing to only upload the changed files, if you change the publish-

ing location without uploading all your site files, the new location will not have all the necessary resources for 

your site. This is because RapidWeaver will only upload the changed files and does not know that you have 

changed upload locations

To ensure that all the files are you your server, simply open your RapidWeaver project file and then go to the 

File > Re-Publish All FIles menu option. A dialogue such as the one below will appear: click OK. 

Note: Re-publishing your entire site will take a little longer than when using 

Smart Publishing. This is due to RapidWeaver uploading every file required for 

your site. After this initial upload, only the changed files will be uploaded with the  

built-in Smart Publishing.
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Setting up a Custom RSS Feed URL

If you’re publishing an RSS feed as part of your blog, then the Custom RSS Feed URL is likely to be of interest 

to you. This setup option in the Blog page’s settings allows you to specify a URL other than the one Rapid-

Weaver generates to be linked to as your RSS feed.

One such example of how this could be useful is the use of the FeedBurner service (from Google). FeedBurner 

provides RSS content producers with statistics on subscriber numbers, and a number of other feed-related 

services. More information on FeedBurner can be found at:

http://www.feedburner.com

Setting up FeedBurner in RapidWeaver

Before enabling the Custom RSS URL, you need to have correctly set up your Site URL, enabled RSS for this 

particular blog and published your site to your webhost.

With the site published, navigate to the page you wish to use with FeedBurner in your web-browser. Find the 

RSS link in the sidebar, and then copy the link to this feed to the clipboard.

Now, register with FeedBurner via their site. After registering, ensure you’re on the ‘My Feeds’ page (linked to 

at the top left of every page) and enter the URL you copied to the clipboard into the ‘Burn a new feed’ box. 

Follow the prompts on the FeedBurner site and by the end of the process, you will have set up a FeedBurner 

URL such as this:

http://feeds.feedburner.com/my-feed

Once you have got this URL, copy it to the clipboard and switch back to RapidWeaver.

Now all you need to do is check the box for the ‘Enable Custom RSS Feed’ and enter this new FeedBurner 

URL into the box, where the http://feeds.feedburner.com/user placeholder is located. Re-publish the site, and 

users will see the FeedBurner link, allowing you to use RapidWeaver’s RSS generation, but route users via 

FeedBurner to subscribe, allowing you to receive statistics on the use and distribution of your content.
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Realmac Software Websites

If you’re looking for information on RapidWeaver, there’s plenty of resources to help you out.

Realmac Software Support Centre:  http://www.realmacsoftware.com/support/

Video Tutorials:    http://www.realmacsoftware.com/rapidweaver/quicktours/

RapidWeaver Site Showcase:  http://www.realmacsoftware.com/showcase/

RapidWeaver Showcase Interviews:  http://www.realmacsoftware.com/showcase/interviews/

RapidWeaver Add-ons:   http://www.realmacsoftware.com/addons/

I Love RapidWeaver:   http://www.iloverapidweaver.com/

Third Party Websites

An up to date list of the numerous Third Party  websites can be found at:

http://www.realmacsoftware.com/rapidweaver/resources/

Retail versions of RapidWeaver

Boxed copies of RapidWeaver are available from a number of locations around the world, including Apple 

Stores. For further details please visit:

http://www.realmacsoftware.com/resellers/


